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Brief summary of the session

● Accessible documents
● OpenOffce.org and odt2dtbook
● Practicle work today:

● Prepare the document
● Create the DTBook
● Let's try with a Daisy player (gh PLAYER)

● Summary and conclusion
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What is an accessible document?

An accessible document is a 
document which can be accessed 
by anyone, regardless the modality 
she/he needs to use.
● Especially, but not only, non visual 
modalities.

● So print disabled people can use it!
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Main constraints (1)

Every piece of 
information that cannot 
be directly displayed in 
any modality, or 
automatically converted 
to be displayed in any 
modality, must have an 
alternate content.

Accessible documents
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Main constraints (2)

It must contain 
explicitly the 
structure.

Accessible documents
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What for ?

● Exchange documents with people 
having or not a print disability

● Deliver documents to pupils, according 
to the US IDEA for instance

● Store documents on a digital library 
for print disabled people

● and probably more...

Accessible documents
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The DTBook format

● DTBook is an accessible format adopted as an 
ANSI/NISO standard (Z39.86), and widely 
used all over the world:
● Lots of digital libraries for the blind (TPB, US 

Library of Congress, BrailleNet, etc)
● NIMAS format (in the framework of IDEA)

● It is maintained by the DAISY consortium as 
part of the DAISY format.

Accessible documents
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How to create DTBooks

● Typing manually in XML!  . . . NOT! ;-)
● Daisy Authoring Software

● See http://daisy.org 
section Tools: Authoring/Production Tools

● Using a word processor with Save-as-Daisy 
function
● One commercial Offce suite as one
● Odt2dtbook enables OOo to create DTBooks 

Accessible documents

http://daisy.org/
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OpenOffice.org and odt2dtbook

● A completely free solution to author 
DTBook documents!

● Both are Open Source software
● Both are cross platform

http://openoffice.org

http://odt2dtbook.sf.net

http://openoffice.org/
http://odt2dtbook.sf.net/
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Why OOo is relevant for creating accessible contents?

● The Open Document format (ODF) now includes 
all necessary features for accessibility

● OOo 3.0 is accessible, see:

http://wiki.services.openoffce.org/wiki/Accessibility
● OOo allows to open a large variety of formats
● OOo is Open Source so it's easy to develop an 

import flter for another format
● OOo is cross platform (Linux, Mac, Win, Solaris)

OOo+odt2dtbook
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What accessible contents?

● Accessible odt fles
● Accessible Web pages

→ Save as HTML document

● Accessible PDFs
→ Export to PDF

● DTBooks!
→ Export to DAISY (odt2dtbook)

OOo+odt2dtbook
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odt2dtbook
● odt2dtbook is an OpenOffce.org writer 
extension, enabling OOo to export to 
DTBook XML 3.

● OpenSource software (GNU LGPL 3)
● Developed in 2008 in UPMC – Paris 6
● Received a Gold Award from the OOo 
Community Innovation Program sponsored 
by SUN Microsystems

OOo+odt2dtbook
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odt2dtbook's features (1)
● Completely cross platform, it can be installed 

in any OpenOffce.org, version > 3.0
● odt2dtbook supports:

● most of the DTBook elements (mapping 
from OOo styles).

● page numbering (including advanced page 
numbering)

● notes (end notes, rear notes), table of 
contents, multilingual documents.

OOo+odt2dtbook
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odt2dtbook's features (2)

● odt2dtbook supports:
● Maths contents conforming to the MathML 
Modular extension of DTBook. 

● Alternative contents, production notes
● Advanced DAISY elements (Front Matter, 
rear matter etc)

● Metadata
● etc.

OOo+odt2dtbook
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Integration with Daisy

Odt2dtbook allows to create fully 
functional DAISY books :
● compatibility has been ensured with the 
DAISY pipeline.

OOo+odt2dtbook
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Let's start practical work!

● Quick overview: let's create a new 
document from scratch:

→ File/New/Text document
● Write a couple of “blah blah” lines
● Generate a DAISY fle:

→ File/Export as Daisy

What's happening now?
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A mean warning!

Odt2dtbook - Warning

Current document has no Heading Style.
It's STRONGLY recommended to use Headings Styles.
Do you really want exporting in one unique level?

OK, Cancel
but why do I have this warning?

Practical work: first document
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Let's improve this!

● Add a few lines like 
this → 

● Set the styles of 
headings to the 
relevant OOo styles

● Now let's do the 
Export as Daisy 
again 

Heading of level 1
blah blah blah blah

Other heading of level 1
Heading of level 2
bluh bluh bluh
Second heading of level 2
bloh bloh bloh

Next heading of level 1
blih blih blih blih

Practical work: first document
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odt2dtbook Export Dialog

Practical work: first document

Identification of
the document

Identifcation of
the document

Creator of
the DTBook

Title of the
DTBook

The CSS allows the
user to view the DTBook
within a simple browser
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odt2dtbook Export Dialog

Practical work: first document

Identification of
the document

Identifcation of
the document

Creator of
the DTBook

Title of the
DTBook

The CSS allows the
user to view the DTBook
within a simple browser

File > Properties 
> Description > Title

Tools > Options 
> OpenOffice.org > User Data 
> First Name (and Last Name)
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Now let's access this document

● We will propose use a software Daisy 
reader:
● gh PLAYER™ (developed by gh, llc.)

http://www.gh-accessibility.com

Practical work: first document

http://www.gh-accessibility.com/
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gh PLAYER™

gh PLAYER™ is a software reading system 
designed for reading NIMAS, DAISY Digital 
Talking Books, and plain text fles while 
providing multiple sensory output.

It supports:
● high contrast large text
● recorded or synthesized speech
● Braille output to a refreshable display
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gh PLAYER™ keyboard commands
● Start the PLAYER or Return

to PLAYER’s Starting Screen...........Ctrl+Alt+G 
● Exit the PLAYER.............................Ctrl+Q or Alt+F4 
● Open Book......................................Ctrl+O 
● Close Book......................................Ctrl+W
● Stop PLAYER Voice ........................Ctrl 
● Stop/Start Narrator Voice ..............Spacebar
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gh PLAYER™ keyboard commands

Navigation
● Next Part........................................Right Arrow 
● Previous Part..................................Left Arrow 
● Change Navigation Mode in TTS

(Word, Segment, Section, Page).......Up/Down Arrows 
● Change Navigation Mode in RA

(Time, Segment, Section, Page)........Up/Down Arrows
● Go to Beginning of Book .................Ctrl+Home
● Go to End of Book ..........................Ctrl+End 
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A more complex document

● Let's create a document using a template

→ File/New/Templates and Documents

> DaisyDTBook

Choose “Empty DTBook”
● Now you will have a set of specifc 
DAISY styles
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Let's get some contents

● For instance let's use some online content 
from wikipedia:

http://en.wikipedia.org/wiki/Eggplant

● Use any other content if you don't like 
eggplants (I think they are delicious!)

● Or: use your own contents

Select contents with headings,
lists, images, etc...

Practical work: complex document

http://en.wikipedia.org/wiki/Eggplant


D
 A

rc
ha

m
ba

ul
t, 

U
PM

C-
Pa

ri
s 

6,
 C

SU
N
 2

00
9,
 s

es
si
on

 O
TH

-1
01

5

Levels

● Levels are mapped with Heading1, Heading2,… 
HeadingX Styles. 

● Headings markup MUST be consistent:

you cannot have a Heading 3 just after an 
Heading 1. 

● Use alternate level markup (in the export 
dialog box) if more than 7 levels are used. 

<levelX> vs <level depth=”X”>

A few tips
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Images

● Images are supported natively, insert an 
image with:

 Insert > Picture > from File... 
● They will be outputed in an “images/” 

directory (if the “link” box remains unchecked) 
● Insert the alternate text using 

Picture … > Options > Alternate (text only) 

(right-click on the picture)

A few tips
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Tables

● Use simple tables ! Avoid nested tables.
● Use Heading lines (there is a “Heading” 
box in the “Options” when a table is 
created)

● Use the style “Table heading” for the 
content of the heading line

A few tips
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Lists
This is a list:
● Linux

● Debian
● Ubuntu

● Solaris
● Mac OS X
● Windows

This is not1:

* Linux

  - Debian

  - Ubuntu

* Solaris

* Mac OS X

* Windows 

1: starts and dashes were inserted manually here 

A few tips
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Lists
This is a list:
● Linux

● Debian
● Ubuntu

● Solaris
● Mac OS X
● Windows

This is not1:

* Linux

  - Debian

  - Ubuntu

* Solaris

* Mac OS X

* Windows 

Ordereded lists are fne too!

A few tips
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Tasks
● Copy a few sections, with titles and paragraphs

● Insert one of the images
● In the paragraphs “History”

● Insert the 2 frst notes of 'History'
● In the paragraph “Synonyms”

● Make a bullet list from the various synonyms
● In the paragraph “Statistics”

● Include the table (don't forget the headings)

Practical work: complex document
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To finish

● Now I'll show how to generate a Full 
Daisy book, using our generated DTBook 
and the Daisy pipeline

http://www.daisy.org/projects/pipeline

Almost the end
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Summary and Conclusion

● We have seen how to easily create a 
DTBook fle with Ooo+odt2dtbook

● The method can be generalised to create 
an accessible ODT fle for any purpose

● This can be done exactly the same on 
other platforms, and the resulting fles 
can be used on any platforms (as well 
the odt and the DTBook)
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OOo+odt2dtbook

The only rich, cross-platform, accessible, 
free and open source environment for 
authoring DAISY books, which is a 
tremendous addition to the disability 
community

http://odt2dtbook.sf.net

Summary and Conclusion

http://odt2dtbook.sf.net/
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Ooo+odt2dtbook can be used:
● by libraries for the blind to convert documents to 

DTBook
● by teachers to create NIMAS documents
● by resource centres who produce accessible 

documents for the print impaired in schools and 
universities

● By any print disabled user to create a DTBook
● By anybody to create a full Daisy book (together 

with the Daisy pipeline)
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If you are interested in Daisy and OpenSource

You could attend the session OTH-2045:

Open Source Software for DAISY - Today 
and in the Future
by Markus Gylling, George Kerscher, Dominque 
Archambault

Friday, March 20 – 10.40am

Marriott - Meridian One DAISY/EASY

Free ad
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thank you

obrigado

chokrane

danke shön

dziekuje

merci
gracias

(arigato)

tak

bayarlalaa
kiittos

dankon

有り難う

你们
(shie-shie)
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